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he advisability of eating in your own 
kitchen is something you often hear 
about, but never does it make more 
sense than when applied in the 

world of software development. Why accept 
that service-oriented architecture is a must 
for your mission-critical backend systems, 
for example, if you find that the developer 
recommending such a trajectory does not 
personally make use of SOA?
	 From this month, as weve all seen, 
Adobe is very prominently eating in its 
own kitchen (its recently-acquired kitchen, 
I should say): it has relaunched Adobe.
com which is now a mega-fusion of the 
original Macromedia and Adobe sites as a 
ColdFusion-powered site. All credit to who-
ever is behind this important and timely 
initiative: what better recommendation of 
a product can there be than that the com-
pany who owns it uses it not just in a cus-
tomer-facing context, but in the customer 
facing context: the company web site?
	 Ben Forta, well known to ColdFusion 
developers worldwide, commented about 
Adobe.com’s new look: “It’s clean. The 
menus are intuitive. Downloads are all listed 
in one place. [There are] shortcut URLs (try  
www.adobe.com/coldfusion for example). 
Having products listed on the homepage is 
great.”
	 The site switchover, which has energized 
both designers and developers, has been 
an object lesson in why I am so confident, 
along with many others Web-wide judging 
by the buzz evident throughout the blogo-
sphere, that the whole that is Macromedia 
+ Adobe is going to be shown over time to 
be considerably greater than the sum of its 
parts.
	 Think about it. This is the first time 
that developers and designers have been 
such close corporate bedfellows, at least at 
Adobe. This high-octane combination of 

two previously disparate communities is the 
fons et origo of the New Adobe, the ratio-
nale for the entire merger. And it is precisely 
why we have re-launched MX Developer’s 
Journal this month as Web Developer’s 
& Designer’s Journal, with Adobe’s close 
cooperation and involvement.
	 The ecosystem reflected in the maga-
zine will, moving forward, be as vibrant 
as any new marriage. The fact is that 
developers have as much to learn from 
designers as designers do from develop-
ers. WebDDJ aims to aid and abet the 
honeymoon right away, and then over 
coming years mirror the rise of this great 
new combined company until its silver 
anniversary at least. 
	 Next month it will be my pleasure to 
introduce you to the new editorial board, 
which we at SYS-CON Media are equally 
proud to say is backed and guided by a 
brand new International Advisory Board 
which reads like a “Who’s Who” of some of 
the very finest interface designers and Web 
developers in the industry today.
	 The opportunity, presented by the com-
ing together of two great companies, to 
widen and deepen the coverage we offer 
each month has proven too strong to resist, 
so hold onto your hats! Next month we’ll be 
drilling down into just some of the welter 
of new topics, themes, and issues that the 
magazine will now be covering, in addition 
to almost everything we already covered for 
the past four years.
	 How Web Developer’s & Designer’s 
Journal takes shape over the coming 
months and years will, as always, be in large 
part a function of feedback from readers, 
too. We can most easily be reached by e-
mail, just send your comments and sugges-
tions to WebDDJ@sys-con.com.
	 Meantime, enjoy. We’ll meet here again 
next month! 

t
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lexstore is a traditional 
Shopping Cart application. 
In this tutorial, we create two 
modules: 

1.	 The administration module is an inter-
nal application used to maintain the 
product database. You use the admin-
istration module to create, update, and 
delete products. 

2.	 The store module is a customer-facing 
application. Customers use the store 
module to browse and filter the prod-
uct catalog. 

	     In the administration module, we 
use Rails’ simple scaffolding feature to 
automatically provide the default infra-
structure to list, view, create, edit, and 
delete products. In the store module, 
we experiment with additional fea-
tures:
•	 Templates 
•	 Filtering using AJAX 
•	 Partial Page Templates 
•	 Builder Templates 
•	 Putting a Flex front-end on top of a 

Ruby on Rails application 

	 This tutorial uses a MySQL database. It 
is assumed that you already have MySQL 
up and running.

Create the Flexstore Database
1.	 Create a database called “flexstore” 

	 Open a command prompt, navigate to the 
bin directory of your MySQL Server installa-
tion, and type the following command:

mysqladmin -uroot create flexstore 

2.	 Import the data 
•	 Download flexstore.sql.zip at http://

coenraets.com/tutorials/flexonrails/
resources/flexstore.sql.zip 

•	 Extract flexstore.sql into the bin 
directory of your MySQL Server 
installation 

•	 Type the following command to 
import the data in the flexstore 
database: 

mysql -uroot flexstore < flexstore.sql

Install Ruby and Rails
1.	 Install Ruby 

•	 Download the Ruby installer at 
http://rubyforge.org/frs/download.
php/4174/ruby182-15.exe 

•	 Run the installer. Accept all the 
default settings. 

2.	 Install Rails 
	      Type the following command in the 

c:\ruby directory:

gem install rails --remote --include-

dependencies

Create the Administration Module
1.	 Create the Flexstore application 
•	 Create a directory called Rails in c:\ 
•	 Type the following command in c:\rails: 

rails flexstore

2.	 Configure the database for the flexs-
tore application 

•	 Edit database.yml in c:\rails\flexs-
tore\config 

•	 Set the database parameter to flex-
store in the development, test, and 
production sections 

3.	 Create a controller for the administra-
tion module 

	     Type the following command in c:\
rails\flexstore

ruby script\generate controller 

Admin

4.	 Create a model for the products 
	     Type the following command in c:\

rails\flexstore: 

ruby script\generate model Product 

5.	 Modify the admin controller to enable 
Rails’ scaffolding 

•	 Edit admin_controller.rb in c:\rails\
flexstore\app\controllers 

•	 Modify the class as shown in Figure 
1.

 
6.	 Test the application 
•	 Start the WEBrick web server installed 

with Rails 
	     Type the following command in c:\

rails\flexstore:

ruby script\server

•	 Open a browser and access the follow-
ing URL: 

http://localhost:3000/admin

tutorial

f

Note: Provide values for userid (-u) 

and password (-p) as appropriate if 

the above values don’t match your 

installation.

Flexstore 
on Rails The traditional shopping cart application

by Christophe Coenraets
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 	     Rails’ scaffolding defined in the Admin controller 
automatically provides default actions and views to 
list, view, create, edit and delete products. Each of 
these actions and views can be overwritten. We over-
write the default index action in the next steps. 

7.	 Define a custom index action 
•	 Edit admin_controller.rb in c:\rails\flexstore\app\

controllers 
•	 Define an index action as shown in Figure 2.

 
8.	 Create the view for the index action 

•	 Create a file name index.rhtml in c:\rails\flexstore\
app\views\admin 

•	 Edit index.rhtml as follows: 

<html>

<head>

<title>Product List</title>

</head>

<body>

<table>

<tr>

<td>Name</td>

<td>Price</td>

</tr>

<% @products.each do |product| %>

<tr>

<td><%= link_to product.name, :action => “show”, :

id => product.id %></td>

<td align=”right”><%= sprintf(“$%0.2f”, product.

price) %></td>

</tr>

<% end %>

</table>

<p><%= link_to “Create new product”, :action => 

“new” %></p>

</body>

</html>

9.	 Test the application. Open a browser and access the 
following URL: 

http://localhost:3000/admin

10.	Validation 
•	 Edit product.rb in c:\rails\flexstore\app\models 
•	 Modify the class as shown in Figure 3.
 

11.	Test the application again. Try to add a product 
without a name or with a non numeric price value. 

Create the Store Module
1.	 Deploy the product images and the flexstore 

stylesheet 
•	 Download assets.zip at http://coenraets.com/tuto-

rials/flexonrails/resources/assets.zip . 

•	 Extract assets.zip in c:\rails\flexstore\public. 

2.	 Create a controller for the administration module 
	     Type the following command in c:\rails\flexstore: 

ruby script\generate controller Store

3.	 Define an index action in the Store controller 
•	 Edit store_controller.rb in c:\rails\flexstore\app\

controllers 
•	 Define an index action as shown in Figure 4.

 
4.	 Create the view for the index action 

•	 Create a file name index.rhtml in c:\rails\flexs-
tore\app\views\store 

•	 Edit index.rhtml as follows: 

<html>

<head>

<title>Flexstore on Rails</title>

<%= stylesheet_link_tag “flexstore”, :media => 

“all” %>

</head>

<body>

<!-- begin catalog -->

<div id=”catalog”>

<% for product in @products %>

<!-- begin thumbnail -->

<div class=”thumbnail”>

<strong><%= product.name %></strong>

<img src=”<%= product.image %>”/>

<div>

<font color=”#CC6600”><b><%= sprintf(“$%0.2f”, 

product.price) %></b></font>

<p>

<%= product.camera==1?’Camera<br />’:’’ %>

<%= product.video==1?’Video<br />’:’’ %>

<%= product.triband==1?’Triband’:’’ %>

</p>

</div>

</div>

<!-- end thumbnail -->

<% end %>

</div>

<!-- end catalog -->

</body>

</html>

5.	 Test the application 
	 Open a browser and access the following URL:

http://localhost:3000/store

Using Partial Page Templates
	 In real life, you would probably have to display 
product thumbnails in different parts of the application. 
In fact, we will need product thumbnails in the filter 
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module described in the next section. To 
avoid code duplication, we will isolate the 
HTML fragment used to render a product 
thumbnail in a partial page template. 
1.	 Create a file named _product.rhtml 

(the partial page template) in c:\rails\
flexstore\app\views\store 

2.	 Open index.rhtml in c:\rails\flexstore\
app\views\store 

3.	 Copy the HTML fragment correspond-
ing to the thumbnail div and paste it in 
_product.rhtml 

4.	 In index.rhtml: 
•	 Delete the content of the catalog 

div (both the for loop and the 
thumbnail div) 

•	 Add the following line of code as 
the sole content of the catalog div: 

<%= render(:partial => “product”, :

collection => @products) %>

	     Because we are passing a collection 
(the list of products) as a parameter, 
the partial page template will be 
repeaded for each item in the collec-
tion. 

5.	 Test the application. The product 
catalog should look the same as in the 
previous section. 

http://localhost:3000/store

Filtering with AJAX
	 In this section, we provide the prod-
uct catalog with filtering capabilities to 
allow the user to specify a price range. In 

Fi
gu

re
 1

Fi
gu

re
 2

Fi
gu

re
 3

Fi
gu

re
 4

Fi
gu

re
 5

April 200610





response to the user’s selection, the prod-
uct catalog is refreshed to display the 
phones in the selected price range only. 
For a better user experience, the product 
catalog is refreshed without refreshing 
the entire page. This is accomplished 
using Rails’ built-in support for Ajax. 
1.	 Add a filter action to the store controller 

•	 Edit store_controller.rb in c:\rails\
flexstore\app\controllers 

•	 Define a filter action as shown in 
Figure 5.

2.	 Modify the index view to allow the 
user to enter a price range 
•	 Edit index.rhtml in c:\rails\flexstore\

app\views\store 
•	 Add the following JavaScript 

include tag immediately after the 
stylesheet link tag 

<%= javascript_include_tag “prototype” 

%>

•	 Add the following html fragment 
immediately before the catalog div. 

<div id=”left”>

<%= form_remote_tag(:update => 

“right”, :url => {:action => :filter}, 

:loading => “$(‘right’).innerHTML=’’”) 

%>

Select your price range:<br />

<br />

From:<br />

<%= text_field_tag(“from”, “0”) %>

<br />

<br />

To:<br />

<%= text_field_tag(“to”, “1000”) %><br 

/>

 

<br />

<%= submit_tag “Filter” %>

<%= end_form_tag %>

</div>

3.	 Change the id of the catalog div to 
“right”. This will allow the stylesheet 
to position the product catalog to the 
right of the filter panel. 

4.	 Test the application 

http://localhost:3000/store

Builder Templates
	 Using Builder templates, you can 
dynamically generate XML documents. 
This provides an integration point that 
allows other technologies to integrate 
with Rails, and leverage productivity fea-
tures of the framwework. In this section, 
we create a template that generates an 
XML document for the product catalog. 
1.	 Add a productlist action to the store 

controller 
•	 Edit store_controller.rb in c:\rails\

flexstore\app\controllers 
•	 Define a productlist action as shown 

in Figure 6.

“For a better user 
experience, the 

product catalog is 
refreshed without 

refreshing the 
entire page”

Notice the use of the partial page tem-

plate to return a list of thumbnails for 

the products in the selected price range. 
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 2.	Create the builder template 
•	 Create a file called productlist.rxml 

in c:\rails\flexstore\app\views\store 
•	 Edit productlist.rxml as follows: 

xml.list do

@products.each do |product|

xml.product do

xml.name(product.name)

xml.description(product.name)

xml.image(product.image)

xml.camera(product.camera)

xml.video(product.video)

xml.triband(product.triband)

xml.price(product.price, :currency => 

“USD”)

end end

end 

3.	 Test the Builder template by accessing 
the following URL in a browser: 

http://localhost:3000/store/pro-

ductlist

Figure 7

Figure 8
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	 You should see an XML document 
similar to the as shown in Figure 7.
 

Putting a Flex Front-End on 
Top of the Rails Application
	 In this section, we use Flex to improve 
the user experience of the product cata-
log. The user interface to capture the filter-
ing criteria is still implemented in HTML.
	 The Flex-based product list uses the 
Builder template created in the previ-
ous section to retrieve the catalog data. 
Contrary to our current version, the Flex-
based list handles product filtering at 
the client-side. Combined with the use 
of rich effects and transparency, this pro-
vides the user with smoother transitions 
between selections. These transitions 
implement the User Interface Design best 
practise of “visual continuity”, and include 
visual cues indicating which products are 
being filtered out and filtered in. 
1.	 Define a Flex action 

•	 Edit store_controller.rb in c:\rails\
flexstore\app\controllers 

•	 Define a flex action as shown in 
Figure 8.

 
2.	 Deploy catalog.swf (the compiled ver-

sion of the Flex-based product cata-
log). 

•	 Download flexcatalog.zip at http://
coenraets.com/tutorials/flexonrails/
resources/flexcatalog.zip. 

•	 Extract flexcatalog.zip in c:\rails\
flexstore\public 

Notes: 
•	 This application was built using the 

Flex XML-based framework. You can 
download the source code at http://
coenraets.com/tutorials/flexonrails/
resources/flexstore_source.zip. 

•	 The application was built with Flex 2 
beta and requires Flash Player 8.5 beta 
2 available at http://labs.adobe.com. 

3.	 First Cut 
	     In our first iteration, the user inter-

face of the application remains very 
similiar to the HTML version. We simply 
replace the HTML-based product list 
with a Flex-based version. 

•	 Create a file named flex.rhtml in 
c:\rails\flexstore\views\store 

•	 Copy the code below in the flex.
rhtml 

<html>

<head>

<title>Flexstore on Rails</title>

<%= stylesheet_link_tag “flexstore”, :

media => “all” %>

<script type=”text/javascript” src=”/

flex/embedflash.js” ></script>

<script type=”text/javascript” src=”/

flex/FABridge.js” ></script>

<script>

function filter() {

var from = document.

getElementById(“from”).value;

var to = document.

getElementById(“to”).value;

var flexApp = FABridge.store.root();

flexApp.filter(from, to);

}

</script>

</head>

<body>

<div id=”left”>

Select your price range:<br />

<br />

From:<br />

<input type=”text” id=”from” 

value=”0”/>

<br />

<br />

To:<br />

<input type=”text” id=”to” 

value=”1000”/><br />

<br />

<input type=”submit” value=”Filter” 

onclick=”filter()”/>

</div>

Fi
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“Contrary to our 
current version, 

the Flex-based list 
handles product 

filtering at the 
client-side”
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<div id=”flex”>

<script>embedFlash(“flexApp”, “/

flex/catalog.swf”, 690, 510, 

“bridgeName=store”);</script>

</div>

</body>

</html>

•	 Test the application 

http://localhost:3000/store/flex

4.	 Optimizing the user experience 
	    In this second iteration, we optimize 

the filtering experience: We use sliders 
(from the Yahoo UI library) to select the 
price range. The Flex-based product list 
reacts to the user’s selection as the slid-
ers are dragged. 

•	 Install the Yahoo sliders. Download 
slider.zip at http://coenraets.com/tuto-
rials/flexonrails/resources/slider.zip, 
and unzip the file in c:\rails\flexstore\
public. 

•	 Overwrite the content of flex.rhtml 
with the code in right side bar.

Resources
•	 Ruby on Rails web site 
•	 Flex on Adobe Labs 

<html>

<head>

<title>Flexstore on Rails</title>

<%= stylesheet_link_tag “flexstore”, :

media => “all” %>

<script type=”text/javascript” src=”/

flex/embedflash.js” ></script>

<script type=”text/javascript” src=”/

flex/FABridge.js” ></script>

<script type=”text/javascript” src=”/yui/

YAHOO.js” ></script>

<script type=”text/javascript” src=”/yui/

event.js” ></script>

<script type=”text/javascript” src=”/yui/

dom.js” ></script>

<script type=”text/javascript” src=”/yui/

dragdrop.js” ></script>

<script type=”text/javascript” src=”/yui/

slider.js” ></script>

<script type=”text/javascript”>

var slider1, slider2;

function init() {

document.getElementById(“camera”).checked 

= false;

document.getElementById(“video”).checked 

= false;

document.getElementById(“triband”).

checked = false;

slider1 = YAHOO.widget.Slider.getHorizSli

der(“slider1”, “thumb1”, 0, 200, 2);

slider1.onChange = function(offsetFromSt

art) {

var newValue = offsetFromStart * 5;

document.getElementById(“value1”).

innerHTML = newValue;

var flexApp = FABridge.store.root();

flexApp.setMinimum(newValue);

};

slider1.onMouseUp = function() {

var flexApp = FABridge.store.root();

flexApp.layoutTiles();

};

slider2 = YAHOO.widget.Slider.getHorizSli

der(“slider2”, “thumb2”, 200, 0, 2);

slider2.onChange = function(offsetFromSt

art) {

var newValue = 1000 + offsetFromStart * 

5;

document.getElementById(“value2”).

innerHTML = newValue;

var flexApp = FABridge.store.root();

flexApp.setMaximum(newValue);

};

slider2.onMouseUp = function() {

var flexApp = FABridge.store.root();

flexApp.layoutTiles();

};

}

window.onload = init;

</script>

</head>

<body style=”margin-top:20px; margin-

left:20px;”>

Select your price range:<br />

<br />

<div id=”slider1” class=”sliderBG”

onkeypress=”return handleHorizSliderKey(t

his, YAHOO.util.Event.getEvent(event))” >

Minimum: $<span id=”value1” >0</span>

<div id=”thumb1” class=”thumb”><img 

id=”img1” src=”/yui/horizSlider.png”></

div>

</div>

<br /><br />

<div id=”slider2” class=”sliderBG”

onkeypress=”return handleHorizSliderKey(t

his, YAHOO.util.Event.getEvent(event))” >

Maximum: $<span id=”value2” >1000</span>

<div id=”thumb2” class=”thumb” 

style=”left:200px”><img src=”/yui/

horizSlider.png”></div>

</div>

<br /><br />

Select the required features<br />on your 

mobile device:<br />

<br />

<table>

<tr><td><input type=”checkbox” 

id=”camera” onClick=”var app = FABridge.

store.root();app.setCamera(this.

checked);”/></td><td>Camera</td></tr>

<tr><td><input type=”checkbox” id=”video” 

onClick=”var app = FABridge.store.

root();app.setVideo(this.checked);”/></

td><td>Video</td></tr>

<tr><td><input type=”checkbox” 

id=”triband” onClick=”var app = FABridge.

store.root();app.setTriband(this.

checked);”/></td><td>Triband</td></tr>

</table>

<div id=”flex”>

<script>embedFlash(“flexApp”, “/

flex/catalog.swf”, 690, 510, 

“bridgeName=store”);</script>

</div>

</body>

</html>

•	Test the application 

http://localhost:3000/store/flex
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Build a Simple Content 
Management System

Let Web authors edit HTML 
content online visually

in this article you’ll learn how to cre-

ate a basic content management 

system using Adobe Dreamweaver 8 

and KTML 4 Lite edition. You can use 

this system to manage content for an 

online newspaper, a company presen-

tation Web site, or a site with articles. 

At the end of this article users of the 

Content Management System will be 

able to:

by Cristian Ivascu
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•	 See the list of articles that exist in the 
site database – with title, description, 
and an Edit link next to each item

•	 Edit the articles using KTML Lite, a free 
online HTML editor.

	 Using KTML Lite, the text boxes or 
text areas used to edit content can be 
replaced with an online HTML editor that 
allows you to format text, style it using 
CSS, upload and insert images and media, 
upload and manage files.
	 You need approximately 20 minutes 
to complete this tutorial.

Getting Started
	 Before starting on this project, there 
are some prerequisites to take care of. 
You need:
•	 Dreamweaver 8: Try www.macromedia.

com/go/trydreamweaver or www.
interaktonline.com/Store/Macromedia-
Affiliate/Redirect/

•	 KTML Lite, a free Dreamweaver exten-
sion from InterAKT Online. You can 
download it from www.interaktonline.
com/Products/Online-HTML-Editor/
KTML-for-Dreamweaver/Try-Download/ 
?from=mm_ktml4

Setting Up the 
Development Framework
	 First you have to set up your appli-
cation server environment and install 
Dreamweaver 8 and KTML Lite. This arti-
cle assumes that you’ve already installed 
and configured a Web server with PHP 
and MySQL support. If not, take a look at 
the following articles from the Developer 
Center:
•	 Setting Up Your PHP Server 

Environment Using Linux, Apache, 
MySQL and PHP (by David Sklar) if you 
use the LAMP platform

•	 Setting Up the PHP, MySQL, and 
Apache Server Platform on Macintosh 
OS X for Dreamweaver MX (by Minh 
Huynh) if you’re working in Mac OS

•	 Setting up PHP for Microsoft IIS (by 
Andrew Stopford) if you’re a fan of IIS 

	 If you’re using Windows, take a look at 
WAMP Server, a free tool that automati-
cally installs Apache, PHP 5, MySQL serv-
er, phpMyAdmin, and SQLiteManager. For 
detailed instructions on installing WAMP 
Server, see this technical note on the 
InterAKT Knowledge Base. 

Defining Your Site
	 Before you build the application, you 
need to set up your site in Dreamweaver. 
For a quick site setup, take a look at this 
technical note: How to Define a Site in 
Dreamweaver. The site will only contain 
two files, which you can create right now:

•	 index.php – displays the list of articles
•	 edit.php – contains a form used to edit 

the content for a selected article.

Setting Up Your Database
	 The application is entirely dynamic. It 
stores articles in a database table. As you 
will only implement displaying and edit-
ing articles, the database will only need 
one table: article_art.
	 Now that you have an idea of how 
your database will look, fire up the sam-
ple SQL script in your MySQL console or 
your favorite database management soft-
ware (such as phpMyAdmin (see www.
phpmyadmin.net/home_page/index.php) 
and create the database. Before you can 
connect to the database you have to cre-
ate the site files.

Create the Database Connection
	 To connect to the database in 
Dreamweaver, follow these steps:
1.	 Open the index.php file. 
2.	 In the Application panel click the 

Databases tab to open it. 
3.	 Next click the Plus (+) button and 

select the MySQL Connection option.
4.	 A dialog box will open, allowing you 

to define the connection parameters. 
Configure it as shown below:

•	 In the Connection Name text box 
enter connSimpleCMS.

•	 In the MySQL server text box enter 
the address (IP or hostname) of the 
computer that’s running the MySQL 
database server.

•	 In the User name text box, enter 
the name of the user that is allowed 
to connect to the database. Note: 
Using “root” as a user name gives 
your applications full rights on the 
database and shouldn’t be used for 
real-life cases.

•	 In the Password text box, enter the 
password of the user that connects 
to the database. Note: If you don’t 
know your database authentication 
information, contact your hosting 
company or your network adminis-
trator.

5.	 In the Database text field enter the 
name of the database you created at the 
beginning of this article – articles. Note: 
Make sure you replace the sample data-
base authentication information values 
with the actual values for your server.

Create the Article List
	 Now you’ll build the main page that 
displays a list of articles in the database. 
The page will display the article title, 
description, and an edit link. To imple-
ment this functionality you need to:
1.	 Create a recordset that retrieves article 

information – the ID, title, and descrip-
tion.

2.	 Display the article title and descrip-
tion and loop through the entire set of 
articles.

3.	 Create a link to the edit page and pass 
the article ID as an URL parameter.

Create the Articles Recordset
	 Dreamweaver retrieves infor-
mation from a database through 
recordsets. A recordset is the result 
of running a SELECT statement on a 
database and contains the records 
returned by the query. To create the 
article recordset:
1.	 Open the index.php page in 

Dreamweaver.
2.	 From the Application panel > Binding 

tab click the Plus (+) button and select 
the New Recordset (Query) option.

3.	 In the user interface that loads config-
ure the recordset properties: table to 

Note: You can build this application on any 

of the supported server models — PHP_

MySQL, ColdFusion, ASP VBScript, or 

PHP_ADODB. The steps are similar. 

However, for this article, we used PHP 5 and 

MySQL as the development framework.

Ta
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1 Articles	 article_art

id_art	 Primary key: unique identifier for each article

title_art	 The article title

description_art	 A short description for the article

content_art	 The body of the article
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use, columns to retrieve, etc., as shown:
a.	 In the Name text box enter the new 

recordset identifier: rsArticles.
b.	 In the Connection dropdown menu 

select the connSimpleCMS database 
connection created at the begin-
ning of this article.

c.	 In the Table dropdown menu select 
the article_art database table.

d.	 In the Columns area click the 
Selected radio button. This way you 
can decide what columns to retrieve 
from the database,

e.	 Holding down the CTRL key (or the 
Apple key on a Macintosh) click on 
the id_art, title_art and descrip-
tion_art columns to select them.

4.	 You can see a fully configured interface 
in Figure 1. Click OK to complete the 
recordset creation process and add it 
to the page.

	 The newly created recordset will 
be displayed in the Bindings tab of the 
Application panel, and you can expand 
it to see the columns it retrieves. You 
will use the dynamic fields to display the 
article details.

Display Article Information
	 Next you have to display the article 
data retrieved from the database. 
Dreamweaver helps speed up the Web 
development process by providing ready-
to-use components for such tasks. To 
display our data you’ll use the Dynamic 
Table command:
1.	 Place the cursor on the index.php page 

in Design view.
2.	 On the Insert bar switch to the 

Application tab, then click the Dynamic 
Table icon.

3.	 Configure the dynamic table to use 
the rsArticles recordset and display all 
the entries. Then hit OK to apply the 
changes and create the table.

4.	 The table automatically displays all 
fields from the recordset and uses the 
column names as table headers. To 
make it usable you have to customize 
it:
a.	 First remove the first column entire-

ly – the one displaying the article 
ID.

b.	 For the second column change the 
header text from title_art to Article 
title.

c.	 For the third column change the 
header from description_art to 
Article description.

d.	 Also check the Header checkbox 
in the Property Inspector for both 
column headers.

5.	 The table now displays the informa-
tion in a clear way. All that’s left is to 
add the link to the edit page. Because 
we’re going to use a single page to 
edit any of the database articles, the 
link pointing to it must also pass the 
unique ID for each article. That way 
the correct one will be loaded for 
editing:
a.	 First add a new column to the 

table, where the links will be. 
Right-click on the last column 
and from the Table category 
select the Insert Rows or Columns 
option.

Figure 1

Figure 2

“Dreamweaver 
helps speed up the 
Web development 
process by providing 
ready-to-use 
components”
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b.	 In the dialog box select the Column 
option and click OK.

c.	 Put the cursor on the second row’s 
last column and type Edit.

d.	 Select the text and click on the fold-
er icon next to the Link text field in 
the Property Inspector.

e.	 Select the edit.php file in the site 
root. Click the Parameters button 
to define what URL parameters will 
be sent along. To tell the edit page 
what article to load in the list you 
must pass its ID as an URL param-
eter.

f.	 For the first parameter Name 
enter id_art. For the Value click 
the dynamic value and select the 
id_art field of the rsArticles record-
set.

g.	 Click OK to create the link.
6.	 Save the page and preview it in the 

browser. It should resemble Figure 3.

	 Now you’ll create the article editing 
form that will display the contents of the 
selected article and let you edit them.

Create the Article 
Editing Form
	 At this point, the articles are listed 
correctly. In this section you’ll move on 
and create the update form using the 
Update Form Wizard from Dreamweaver. 
Then you’ll enhance the update form by 
replacing the default text area with the 
KTML editor.
	 First create the basic update form:
1.	 Open the edit.php file in Dreamweaver.

2.	 First add a filtered recordset that 
retrieves only the article referenced by 
the ID in the URL parameter from the 
database. Configure the recordset as 
follows:
a.	 For the name, use rsArticle. Use the 

same database connection as before 
– connSimpleCMS.

b.	 This time retrieve all the columns 
in the database. Check the All radio 
button.

c.	 In the Filter dropdown menu select 
the column to filter the recordset 
by – id_art. For the method use the 
URL parameter and for the reference 
use id_art.

d.	 Click OK to create the recordset.
3.	 In the Insert bar switch to the 

Application tab and click on the 
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Update Record (Record Update Form 
Wizard) icon.

4.	 Configure the user interface as follows:
a.	 In the Connection dropdown menu 

select connSimpleCMS.
b.	 In the Table to update dropdown 

menu select the article_art table.
c.	 In the Select record from dropdown 

menu select the rsArticle recordset.
d.	 In the After updating, go to text box 

enter index.php. This way after the 
article’s been updated the user will 
be returned to the list.

e.	 In the Form fields grid click the 
id_art field to select it. Next click 
the Minus (-) button to remove it 
from the operation. The article ID 
is set to automatically increment 
so you don’t need to give it a 
value.

f.	 Select the title_art field. In the Label 
text field enter Article title.

g.	 For the description_art field set the 
Label to Article description. In the 
Display as dropdown menu select 
Text area.

h.	Do the same for the content_art 
field: set the Label to Article content 
and the Display as to Text area.

i.	 Click OK to create the update form.
5.	 You can see a sample configured inter-

face in Figure 4.
6.	 The last thing to do is to add a Cancel 

button so the user can return to the 
list.

7.	 Put the cursor next to the Update 
record button generated automatically 
by the wizard. 

8.	 From the Forms tab of the Insert bar 

click the Button icon to add a new one. 
Then click on it to select it and from 
the Property Inspector set its action 
to None. In the Value text field enter 
Cancel.

9.	 With the button still selected expand 
the Tag panel and select the Behaviors 
tab. Select the Go to URL behavior.

10.	In the dialog box, enter index.php for 
the URL to load. Click OK to apply the 
changes.

	 You can test the editing form now. 
Simply load the article list and click the 
Edit link for one of them. You’ll find that 
it’s not that easy to edit the content, 
especially if you need to add HTML for-
matting to the text.
	 Next you’ll replace this text area 
with KTML Lite, the online HTML editor 
that will make editing content a breeze. 
KTML allows even non-technical users to 
edit content in a WYSIWYG environment 
much like they would in Microsoft Word 
or some other word processors.

Replacing a Standard Textarea with a 
Rich Text Editor
	 Now it’s time to make the staff that 
will work to update the site happy. 
Instead of learning HTML, they’ll put their 
Word skills to good use; the textarea will 
turn into something much friendlier – a 
visual HTML online editor, where you can 
apply formatting to text, insert images, 
create hyperlinks or tables.
	 Before starting to replace the textarea 
with KTML Lite, make sure you have the 
extension installed.

	 An extension is a tool that can be 
added to Dreamweaver to bring greater 
functionality and enhance its capabilities. 
Extensions can vary from small HTML pro-
grams to complex Java applications. Their 
purpose is to reduce the areas of manual 
coding, and minimize repetitive tasks to 
increase productivity.
	 You can install and manage exten-
sions using Macromedia Extension 
Manager, an accessory to Dreamweaver. 
Extensions are usually delivered as 
executable MXP files. Just run them and 
Extension Manager will initiate the instal-
lation. You can find a lot of extensions on 
the Dreamweaver Exchange (see www.
macromedia.com/cfusion/exchange/
index.cfm), the biggest repository for 
extensions on the Web.
	 The steps to follow to enhance the 
page are:
1.	 Open the edit.php page.
2.	 In the Application panel click the 

Server Behaviors tab to open it.
3.	 Click on the textarea used for editing 

the article contents to select it.
4.	 In the Server Behaviors tab click the 

Plus (+) button > KTML 4 > KTML 4 
Lite.

5.	 The KTML 4 Lite server behavior has four 
sets of options that you can use to con-
figure the editor to suit your needs: editor 
size, toolbars, buttons, security permissions, 
and more, as you can see in Figure 7.

6.	 In the Basic tab, set primary editor 
options:
a.	 In the Apply to field dropdown 

menu the ID of the textarea is 
already selected. 
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b.	 In the Width text box enter 650. For 
Height enter 500. This will be the size 
of the editor.

c.	 The KTML editor lets you format 
content using CSS styles. In the CSS 
style text field enter the path to the 
stylesheet you want to use or leave it 
at the default value.

d.	 KTML lets users upload images, mov-
ies, and documents to the server 
and insert them in their pages. In 
the Files upload folder and Media 
upload folder text boxes you can 
specify where the uploaded files will 
be stored. Leave these settings at 
their default values. These folders 
will be automatically created for you 
when first used.

e.	 In the Show toolbar dropdown 
menu select On load. This way, the 
toolbar will be displayed as soon as 
the editor loads.

f.	 In the Show property panel drop-
down menu select Yes. This will dis-
play the Property Inspectors for all 
the supported elements.

7.	 Next configure what toolbars and but-
tons are displayed in the Toolbars tab:
a.	 In the Toolbar presets dropdown 

menu you can select what pre-
defined configuration of buttons 
you want to use.

b.	 Using the grid you can add or 
remove toolbars from the current 
configuration. For each selected 
toolbar, you can use the checkboxes 
to display or hide buttons. You don’t 
have to change anything on this tab.

8.	 In the Security tab define file upload 
restrictions:
a.	 In the Allowed document types and 

Allowed media types lists, specify 
the file extensions that can be 
uploaded to the server.

Figure 6

“An extension 
is a tool that 
can be added to 
Dreamweaver 
to bring greater 
functionality and 
enhance its 
capabilities”

April 2006 23



b.	 In the Maximum file size text 
box you can enter the maximum 
allowed size for uploaded files.

c.	 In the Strip server location select 
whether the full server path will be 
used for links or not.

9.	 When done configuring all options, 
click OK to close the user interface and 
apply the changes. A translator – a scale 
image that represents the editor – is 
now displayed instead of the textarea.

	 Using the online HTML editor, the site 
users don’t have to have a diploma in HTML 
editing, but simply know how to use a basic 
word processor and they’ll do just fine.

Where to Go From Here
	 You can find out more about KTML 
from the following articles:

•	 The KTML live demo page, accessible 
at www.interaktonline.com/Products/
Online-HTML-Editor/KTML-for-
Dreamweaver/Live-Demos/, where you 
can use the editor and discover what it 
can do.

•	 Unveiling KTML at www.interakton-
line.com/Products/Online-HTML-
Editor/KTML-for-Dreamweaver/
Documentation/Articles/
Unveiling+KTML+4.html?id_art=28 
shows the features and several uses of 
the editor.

•	 Learn how to build and edit content 
for a Travel Agency site from the 
Adobe developer center article at 
www.macromedia.com/devnet/dream-
weaver/articles/dw_ktml.html.

•	 The user manual is available 
online in Flash format and you can 

access it at www.interaktonline.
com/Documentation/KTML/index.
html.

•	 If you want to push KTML’s limits and 
extend what it can do for you then you 
should take a look at the API docu-
mentation at www.interaktonline.com/
Documentation/KTMLLITE-API/index.
html.

•	 KTML 4 Lite also has a big brother 
– the full version that adds more 
Property Panels for almost all the ele-
ments you can insert from the editor, 
spellchecking, XHTML compliance, 
even an integrated image editor. You 
can find out what the differences are 
between the two versions at www.
interaktonline.com/Products/Online-
HTML-Editor/KTML-for-Dreamweaver/
VersionComparison/. 

Fi
gu

re
 7

April 200624





acromedia Flash is every-
where. No seriously, it 
is everywhere. Not only 
is Flash used for online 

and offline movies, websites, games, and 
applications but it’s also used for DVDs 
and broadcast television.
	 In fact, my first few years working 
with Flash (versions 3 and 4) were dedi-
cated to authoring content for several 
broadcast animated series. Exporting 
from Flash to video formats so I could 
import and edit them on an Avid work-
station was my only authoring require-
ment of Flash. I didn’t need to know 
about Flash for the web, ActionScript, 
optimization, preloaders, or even buttons. 
It was analog Flash at its purest and that 
was the world of Flash that I lived in.
	 Eventually my Flash world expanded 
into the online realm of dynamic content 
when Shockwave.com asked me to devel-
op an online animated series. I quickly 
learned how Flash was truly the Swiss 
army knife of design and development 
tools.
	 Today some of my clients request 
that their online content be repurposed 
for video, so the line between Flash for 
online and offline content occasionally 
becomes blurred.
	 You can do the same for your clients-
or for yourself. What you need to do is 

learn how to set up the Stage so that 
your Flash project outputs optimally to 
video, use broadcast-safe colors in your 
project, and export your project to video.

Setting Up the Stage for Video
	 Let’s start with the basics. Open a 
new Flash document and then select 
Modify > Document (Control+J) to open 
the Document Properties dialog box (see 
Figure 1).
	 Here you determine the width and 
height of the Stage and its frame rate. But 
before you change anything, you need to 
decide what aspect ratio you are author-
ing to, so read on before you change 
anything.
	 NTSC (National Television Standards 
Commission), the video standard used 
in North America and most of South 
America, uses a 4:3 aspect ratio, which 
basically means a rectangular shape like 
a television set. To break it down in sim-
pler terms, 4:3 means that for every four 
units wide, the picture is three units high. 
Apply this formula to a 16:9 screen and 
you’ll get 16 units of width for every nine 
units of height. Simple arithmetic so far, 
but it’s about to get tricky.
	 NTSC uses a pixel resolution of 720 x 
480 pixels. But guess what? NTSC doesn’t 
use square pixels; they are rectangular. 
(Why do they have to make everything so 
complicated?) A problem arises when you 
develop content for video on your com-
puter because you are creating square 
pixels to be displayed as rectangular pix-
els. That means your image will no longer 
have the correct aspect ratio and will look 
slightly stretched. To compensate for this 
pixel chaos, you need to adjust the width 

of the movie so that the pixel resolution 
is now 720 x 540. Panic is now over.
	 NTSC uses a frame rate of 29.97 or 30 
frames per second (fps). You can export 
Flash movies that have different frame 
rates such as 12, 15, or 24 fps without 
worry. These frame rates will be convert-
ed to 30 by your video editing software, 
although a movie authored at 12 fps 
and converted to 30 fps will not look as 
smooth as a movie originally authored at 
30 fps.
	 PAL (Phase Alternating Line), the 
predominant video standard outside the 
Americas, also has a 4:3 aspect ratio but 
uses a 720 x 576 pixel resolution and a 
frame rate of 25 fps. PAL has a greater 
resolution than NTSC and therefore has 
a better picture quality. Its higher color 
gamut level produces higher contrast 
levels as well. But the lower frame rate, 
compared to NTSC’s frame rate, will not 
be as smooth.
	 Film uses 24 fps, which is also a 
popular frame rate among animators. 
Although you can use 24 fps in your Flash 
project, when you export it to video you 
will need to convert the frame rate as 

Migrating Flash 
Projects to Video Creating broadcast quality Flash projects

by Chris Georgenes

flash

m

Tip: If you are authoring several 

Flash movies that use the same prop-

erties, click the Make Default button 

before you click OK in the Document 

Properties dialog box. This ensures 

that every new Flash document you 

create will share these properties.

Tip: If you convert the safety layer to 

a guide layer, it will not be exported 

with the rest of the movie’s contents. 

Because a guide layer is not included 

upon export, it’s a cool way to retain 

the assets in your movie that you 

otherwise would not want to delete 

from the Stage. To convert a layer 

to a guide layer, right-click the area 

containing the layer name and select 

Guide in the context menu (see 

Figure 3).
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well. This is easily done during the export 
process by specifying the appropriate 
frame rate for the video format to which 
you are authoring (PAL or NTSC). Keep in 
mind that this does not speed up your 
animation; rather, it simply makes your 
animation not appear as smooth. Because 
film and PAL have nearly the same frame 
rate (24 and 25, respectively), there will 
be hardly any visual difference.
	 Widescreen television, or HDTV, uses 
an aspect ratio of 16:9, which you can 
convert the same way by multiplying 16 
and 9 by the same number. For exam-
ple, 16 x 100 = 1600 and 9 x 100 = 900, 
for a total width and height of 1600 x 
900 with which to author HDTV con-
tent. Depending on your display size 
and resolution, you may want to adjust 
the amount by which you multiply 16 
and 9.
	 While resolution is important in video, 
Flash is resolution-free. As long as you 
are working in the correct aspect ratio, 
you can always resize your video when 
exporting. If you are using imported bi 
tmaps in your Flash movie, you will want 
to use a width and height that exactly 
matches your final output to prevent the 
images from becoming scaled in Flash.
Back to Flash and your open Document 
Properties dialog box. Type in the width 
and height of your aspect ratio, enter the 
frame rate, and click OK.

Ensuring Title and Action Safety
	 Televisions do not generally display 
the entire width and height of your 
movie. They show a smaller portion of 
the true display size. Cropping a bit on 
all four sides will almost guarantee that 
what you create in Flash shows up in its 
entirety on a TV set.
	 Any good video editor will take this 
discrepancy into account. There’s nothing 
worse than finding out too late that the 
title sequence you labored over for 10 
hours appears on most TVs with several 
characters cropped, or is even completely 
invisible. To prevent this, you need to 
define which area is considered the safe 
zone within the dimensions of your 
movie.
	 There are two safe zones to consider: 
the action-safe zone and the title-safe 
zone. The action-safe zone lies 10 percent 
in from the absolute edge of the video. 

You can assume that everything falling 
within this zone will appear on a televi-
sion screen.
	 The title-safe zone is smaller than the 
action-safe zone (see Figure 2) because 
it is much more important to ensure that 
all titles are clearly legible without any 
chance of a single letter being cropped. 
For this reason, the title-safe zone lies 20 
percent in from the absolute edge of the 
video. When you add titles to your movie, 
make sure they are positioned entirely 
within this safer title-safe zone to avoid 
being cropped.
	 Place the title-safe zone in your Flash 
project on its own layer above all other 
content. This way when you are ready to 

Figure 1
Figure 2

Figure 3
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export to video, you can delete this layer 
to prevent it from being included in the 
video file.

Using Safe Colors
	 The computer monitor you are look-
ing at as you read this article is designed 
to display the full range of 256 RGB color 
values (0-255). By contrast, television 
can display only a limited range of color 
values. There’s a good chance that some 
colors you are using in your Flash movie 
fall outside the television value range, 
resulting in very noticeable color bleed-
ing.
	 Open the Color Mixer tab in the Color 
panel and select pure white in the fill 
color swatch. The RGB values will update 

to reflect the values 255-255-255, where 
R = 255, G = 255, and B = 255 (see Figure 
4).
	 Now select black in the color swatch 
and watch the RGB values update to 
show 0-0-0 (see Figure 5). This represents 
the full 256-color range of the RGB color 
value that is legal for computers to dis-
play.
	 For television, however, you must 
limit this range to between 16 and 235 
colors. This means that the color value of 
black should be 16-16-16 and the color 
value of white should be 235-235-235 
(see Figure 6).
	 The color red is one of the more usual 
suspects because it has a tendency to 
bleed more than any other color. To mix 
a television-safe value for red, open the 
Color Mixer tab in the Color panel and 
select the brightest red by clicking the fill 
color swatch and selecting the red color 
swatch on the far left side (see Figure 7).
	 Notice how the RGB color values are 
255-0-0, which is far from the legal color 
gamut that television can display. Edit 
this color value by highlighting the R 
value of 255 and entering 235. Highlight 
the G value and enter 16 and do the 
same for the B value. You now have an 
NTSC-safe red color swatch with an RGB 
value of 235-16-16. Use the Type pop-up 
menu to add this swatch to your palette 
(see Figure 8).
	 If you apply this simple formula each 
time you mix colors in Flash, you will 
remain well inside the television color 
value range. The blue used for the pupils 
of my boy character, for example, are con-
sidered safe because they have an RGB 
value of 16-51-204 (see Figure 9).

Handling Movie Clips and Graphic 
Symbols
	 Exporting Flash projects to video 
format requires everything to be on 
the main Timeline. Graphic symbols are 
treated as part of the Timeline because, 
technically, they are in sync with it. So if 
you have nested animations, make sure 
to use the Graphic symbol type for all 
your symbols.
	 There is more than one way to create 
a symbol. If you have a vector drawing 
or imported image on the Stage, select it 
and choose Modify > Convert to Symbol. 
You will be presented with the Convert to 
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Symbol dialog box (see Figure 10), where 
you can type in a symbol name, select its 
type, and determine its registration point.
	 Avoid movie clips. Avoid movie clips. 
Avoid movie clips! I can’t emphasize 
enough the importance of avoiding 
the use of movie clip symbols contain-
ing content beyond the first frame. The 
movie clip in the exported movie will 
appear as a static image only. Did I say to 
avoid movie clips?
	 If any of your movie clips contain 
an animation, you must convert it to 
the Graphic symbol behavior. Movie 
clips are independent from the main 
Timeline and are not synchronized with 
other timelines. Graphic symbols play in 
sync with the main Timeline and other 
graphic symbols. They also render to 
video format, while movie clips do not. To 
convert a Movie Clip symbol to a Graphic 

symbol, select the movie clip instance 
on the Stage and, from the Property 
inspector (Window > Properties or press 
Control+F3), change its behavior from 
Movie Clip to Graphic (see Figure 11).
	 Next, change the behavior of the 
instance from Single Frame to either 
Loop or Play Once, depending on your 
needs (see Figure 12). Make sure there 
are enough frames on the main Timeline 
to accommodate the graphic symbol’s 
length. To lengthen the timeline, choose 
a frame in the Timeline panel that rep-
resents the duration of the movie and 
select Insert > Timeline > Frame (or press 
F5). You will now be able to drag the play-
head back and forth (or press Enter) to 
see your nested animation play.
	 In general, when you author content 
for video, avoid dynamic content com-
pletely. Flash documents that include 

ActionScript, buttons, and dynamically 
loaded content will fail during export. 
Even a simple stop(); action causes the 
export to fail. But if you do have dynamic 
content, read the later section on 
SWF2Video.

Exporting to Video
	 Your movie is now ready for export-
ing. You have the right aspect ratio, frame 
rate, and colors, and everything is on the 
main Timeline or set as Graphic symbols. 
You’re good to go.
	 You have more than one option when 
you export your video, and there are 
slight differences depending on whether 
you are authoring in Mac OS or Windows.
	 Basically it comes down to three 
different options: AVI (Audio Video 
Interleave), Apple QuickTime, or an 
image sequence. Formerly your choice 
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of platform dictated your format. 
Macintosh users exported to QuickTime 
and Windows users exported to AVI. Now 
both formats are compatible across plat-
forms.

AVI and QuickTime Export Settings
	 Mac users have the option of export-
ing to QuickTime video, which results in 
a true pixel-based video file. Exporting to 
QuickTime on Windows produces just a 
Flash movie in QuickTime Player; it is not 
a pixel-based video file. The only way to 
export to a true pixel-based video format 
in Windows is to purchase QuickTime 
Pro (currently US$29.99 from Apple 
Computer), open the exported movie 
from Flash in QuickTime Pro, and then 
export it again as a QuickTime movie.
	 When you export from Flash to AVI or 
QuickTime, you will have a few options 
from which to choose. Typically it is a 
good practice to keep your movie as 
uncompressed as possible and at the 
highest color bit available.

QuickTime Export Settings
	 There are many settings you can 
make in the Export QuickTime dialog box 
(see Figure 13):
•	 Dimensions: Enter a width and height 

in pixels for the exported QuickTime 
video, or select Match Movie to make the 
QuickTime video the same size as the 
Flash SWF file and keep its aspect ratio.

Alpha: Control the transparency mode of 
your movie, as follows:
•	 Alpha Transparent makes the Flash 

background transparent, allowing con-
tent behind it to be visible

•	 Copy makes the Flash track opaque 
and masks all content in tracks (layers 
within the QuickTime wrapper) behind 
the Flash track

•	 Auto makes the Flash track transparent 
if it’s on top of any other tracks and 
opaque if it’s the bottom (or only) track 
in the SWF file

Layer: Select where in the stacking order 
the Flash movie resides, as follows:
•	 Top places the Flash track always on 

top of other tracks in the QuickTime 
video

•	 Bottom positions the Flash track 
behind other tracks

•	 Auto positions the Flash track in front 
of other tracks if any Flash objects are 
in front of video objects in the Flash 
application, and behind all other tracks 
if Flash objects are not in front

•	 Streaming Sound: Export all streaming 
audio used in the Flash project to a 
QuickTime soundtrack.

•	 Controller: Specify the QuickTime con-
troller style used to play the exported 
video: None, Standard, or QuickTime 
VR.

•	 Loop: Repeat the video when it reach-
es the last frame.

•	 Paused at Start: Pause the video until 
some user interaction occurs.

•	 Play Every Frame: Play every frame of 
the movie without skipping (sound is 
disabled).

Figure 9

Figure 10

Figure 11

Figure 12
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•	 File Flatten (Make Self-Contained): 
Combine the Flash content and 
imported video content into a single 
QuickTime video file, making it easy to 
distribute and archive.

	 Deselecting this option links the 
QuickTime file to whatever external files 
compose it. This keeps the QuickTime file 
size consequently smaller. It’s also useful 
if you ever want to edit one or more of 
the dependant files individually. Once you 
update them, the QuickTime movie reflects 
your changes because it references them 
externally. Of course, if you ever move, 
delete, or corrupt any referenced file, the 
QuickTime movie will not be able to show it.

AVI Export Settings
	 There are not as many settings to 
make in the Export Windows AVI dialog 

box as there are for QuickTime (see Figure 
14):
•	 Dimensions: Enter a width and height 

in pixels for the exported AVI video. 
Check the Maintain Aspect Ratio 
option to keep the same aspect ratio 
as your Flash movie.

•	 Video Format: Select 18-bit, 16-bit, 24-
bit color or 32-bit with Alpha format. 
An 18-, 16-, and 24-bit color represents 
eight bits for every RGB color value. A 
32-bit color is the same, with the addi-
tion of eight more bits representing 
the transparency of the color value.

•	 Compress Video: Display a dialog box 
allowing you to select from a list of 
standard AVI compression options.

•	 Smooth: Apply anti-aliasing to the 
exported AVI movie.

•	 Sound Format: Set the sampling rate 
and size of the soundtrack (if sound is 

present) and whether to export it in 
mono or stereo.

Handling Audio
	 If your Flash project contains any 
audio, there are some important techni-
cal details you need to consider. Quality is 
important, specifically sounds recorded in 
stereo at a 44.1 kHz sampling rate and 16-
bit depth. When you develop a project for 
video output, it is always best to record at 
the highest quality whenever possible.

Working with Compressed Audio
	 In a situation where your sound 
file is relatively long, say five minutes 
or more, it may be best to convert it 
to a compressed format that Flash can 
import, such as MP3. Once you convert 
your audio file to a compressed format, 
the file size will be much easier to work 
with. Importing a compressed version of 
the sound into Flash also helps keep the 
movie file size manageable. Just make 
sure to retain a backup copy of the origi-
nal high-quality sound file so you can 
reimport it into your Flash file for final 
export later.
	 Speaking of length, the actual run-
ning time of a half-hour television pro-
gram is approximately 22 minutes. But 
working with a 22-minute Timeline in 
Flash is potentially problematic. At 30 
frames per second, a 22-minute anima-
tion ends up being 39,600 frames long. 
Because Flash is not really capable of 
handling timelines of this length, instabil-
ity can become a factor. To avoid crashing 
and the potential of a corrupt file, break 
up the audio into smaller chunks and 
import them into several different Flash 
files that you can later stitch together 
in your video editing program. I recom-
mend that you work in smaller durations, 
somewhere between 30 and 60 seconds 
long.
	 There are a number of useful audio 
editing tools available to edit your sound 
files. My personal favorites are Sound 
Forge Audio Studio and Vegas, both from 
Sony. They run only in Windows. Adobe 
Audition is another choice for Windows 
users. For Mac users, there’s Soundtrack 
Pro from Apple. If you are on a budget, 
try Audacity, a very capable and open-
source (free) audio editing tool available 
for Mac OS, Windows, and Linux.
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	 When your animation is complete 
and you are ready to export it to video, 
delete the compressed sound files from 
the Flash movie. Export only the anima-
tion to your chosen video format and 
then import this video file, along with 
the original high-quality sound files, into 
your video editing program of choice, 
such as Adobe Premiere or Apple Final 
Cut Pro. This method not only keeps your 
FLA sizes to a minimum but also provides 
some editing flexibility because both 
sound and animation are maintained on 
separate tracks for further editing.

Synchronizing Animation with Sound
	 To sync your animation with the 
imported audio in Flash, you must embed 
the audio in the main Timeline. Select 
File > Import and locate the audio file on 

your hard drive. Once it’s imported, cre-
ate a new layer on your main Timeline, 
select the first keyframe in this new layer, 
and locate the sound file in the Property 
inspector from the Sound pop-up menu.
	 By default, the sound behavior is 
set to Event. An Event sound plays in its 

entirety, independent of the Timeline, 
and does not ensure proper synchroniza-
tion with the animation. You can change 
the behavior from Event to Stream by 
selecting the Sync pop-up menu in the 
Property inspector. When you set the 
sound to Stream, you will be able to grab 
the playhead and move it back and forth 
across the Timeline and hear the sound 
play. This is called scrubbing. Sound files, 
when set to Stream, are embedded in the 
Timeline and will be in sync with the ani-
mation that resides on the Timeline and 
any graphic symbols containing nested 
animation.

Exporting Dynamic Content 
with SWF2Video
	 I know I said earlier that when you 
author content for video, avoid dynamic 
content completely, but when it comes 
to exporting a Flash movie with dynamic 
content-anything that requires user input 
or that goes beyond just time-based ani-
mation (for example, using ActionScript)-
you do have solutions.
	 One such solution is SWF2Video by 
Flashants, a powerful utility that converts 
SWFs published from Flash to AVI format. 
This includes movie clips, ActionScript 
events, human interactions, and audio.
	 The SWF2Video interface is surpris-
ingly simple. Select File > Open and 
navigate to the SWF movie published 
from Flash and choose File > Create AVI. 
After naming your AVI file, you will be 
presented with the AVI Export Setting 
dialog box. From here you can select how 
the sequence is exported as well as edit 
the dimensions, apply compression or 
leave as uncompressed, set audio options 
(if any), and more.
	 The SWF2Video IDE is amazingly sim-
ple. Upon launch there’s little more than 
a window with the familiar File, Control, 
Options, and Help menus. Select File > 
Open and navigate to your SWF. Open 
the File menu again and select Create AVI 
(see Figure 15) or Create Image Sequence. 
SWF2Video even supports batch process-
ing of files.
	 When you select Create AVI, the AVI 
Export Setting dialog box opens, allowing 
you to refine your movie considerably 
further (see Figure 16).
	 The Sequence settings are as follows:
•	 Skip “goto backward frame” in main 
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timeline: If the Flash movie contains a 
loop in the main Timeline by using the 
gotoAndPlay(0); command, select this 
option to break the loop by ignoring 
the ActionScript code.

•	 Frame by frame in main timeline: 
Convert the main Timeline animation 
into a keyframe sequence.

•	 Normal: Convert with the movie’s 
normal playback sequence, including 
movie clips and ActionScript events.

	 For the Duration setting, specify the 
start and end points during export by 
entering the exact frame numbers.
	 There are several Video settings to 
make as well:
•	 Frame rate: Default is the original set-

ting of the movie. If you modify this 
value, the output video will be faster or 
slower than the original movie.

•	 Color Depth: Select 24 bits RGB or 32 
bits RGB with Alpha format. The 24-bit 
color setting represents eight bits for 
every RGB color value. The 32-bit color 
setting is the same as 24 bits with the 
addition of eight more bits represent-
ing the transparency of the color value.

	 Clicking Select in the Video section 
opens the Video Compression dialog 
box (see Figure 17). Here you can choose 
the appropriate compressor to apply to 
your video. Leave this set to Full Frames 
(Uncompressed) because this is always 
best when working with high-quality 
video. People do not generally compress 
this because otherwise loss of quality will 
occur.
	 Other video compression settings are 
as follows:
•	 Compression quality: Select from 0 to 

100 to adjust the amount of compres-
sion.

•	 Key frame interval: If you select a 
compressed format, you will have the 
option of setting a keyframe interval 
(see Figure 18). This setting deter-
mines how frequently a full frame of 
the source video is preserved in the 
Timeline. A smaller value results in 
more keyframes, and subsequently a 
larger file size. A greater value results in 
fewer keyframes and a smaller file size. 
Animation with little motion (such as 
a talking head) may be suitable with a 
larger keyframe interval value, while a 

movie with an abundance of animation 
may benefit from a smaller keyframe 
value.

•	 Data rate: Specify the data rate of the 
converted video.

	 If you have any audio in your Flash 
project, you’ll want to make the following 
Audio settings:
•	 Record from current SWF file: Record 

audio from the current SWF file and 
then merge it with the video.

•	 Recording volume: Adjust the vol-
ume level of the waveform recording 
device.

•	 From WAVE file: Use an external WAVE 
file to create your audio by clicking 
Browse to choose the WAVE file. The 
audio data of this WAVE file is merged 
with the video data; the audio in the 
original SWF file is ignored.

	 The final two settings are important 
to consider too:
•	 Split file when exceeding: Specify the 

file size limit before the file is split into 
two different files.

•	 Play after creating: Open the output 
AVI file with your preferred default 
media player when export is complete.

	 SWF2Video is the perfect companion 
to Flash for anyone wanting to convert 
dynamic Flash files to a time-based video 
format.
	 Once you export your Flash project 
to your preferred video format, you can 
import it into a video editing program 
such as Premiere or Final Cut Pro, or a 
compositing and motion graphics pro-
gram like Adobe After Effects, for further 
editing, special effects, and color correc-
tion.

Where to Go from Here
	 My Flash career began with authoring 
content for broadcast video. At the time I 
was the director of creative development 
for an animation studio in the Boston area. 
Part of my job was to research and imple-
ment graphics and animation software 
into the production process. We produced 
and animated content for Comedy Central, 
ABC, and The Cartoon Network, and were 
completely desperate to find the right tool 
to replace the 	 animation program 
we were rapidly outgrowing.

	 When I discovered Flash, I knew right 
away that this tool would allow us to 
grow as an animation studio. It had all the 
features we were looking for, including 
support for QuickTime and AVI formats.
	 I hope this article successfully conveys 
some of my experience. It should help 
answer at least some of your Flash-to-
video questions. Future articles will cover 
using After Effects to add some cool visual 
effects to your movies and burning video 
content to DVD using Adobe Premiere.
	 In the meantime, here are some other 
resources that address exporting Flash 
to video and creating broadcast-quality 
Flash projects:
•	 Taking Flash Animation to DVD Video 

(by Brooke Burgess)
•	 Flashants Forum (makers of 

SWF2Video)
•	 Flash to Video Tutorial (from FlickerLab)
•	 Flash to Video Encoder PRO 4.2 (from 

GeoVid)
•	 Flash MX Design for TV and Video (by 

Janet Galore and Todd Kelsey; Wiley, 
2002) 

Chris Georgenes is a full-time freelance 

artist, animator, and all-around designer 

for the web, CD-ROM, and television. His 

clients include Pileated Pictures, LucasArts, 

Universal Records, Plot Developers, and 

AOL, among others. He maintains www.

mudbubble.com as his online portfolio and 

www.keyframer.com as his Flash tutorial 

website. Chris is also a member of Team 

Macromedia.
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s the World Wide Web’s land-
scape has evolved from the 
days of multimedia-void static 
HMTL pages, the need for a 

dynamic interactive medium for Web 
applications has become apparent. 
Adobe Flash, as many developers know, 
is the most widely distributed, capable 
technology for achieving this new 
Internet medium. But Flash develop-
ers can’t achieve the features expected 
from modern Web applications with 
Flash alone – for Flash’s resources to be 
put to proper use, Flash must team up 
with a server-side technology capable 
of functionality such as database access 
and file manipulation. Microsoft’s 
newest Web technology, ASP.NET, is a 
perfect counterpart for Flash, putting 
powerful capabilities at the fingertips 
of Flash developers, created using a 
programming language that is both 
friendly and familiar to ActionScript 
developers.

ASP.NET
	 ASP.NET, like other Web platforms 
such as PHP, JSP, and ColdFusion, is a set 
of Web development technologies that 
can be used to create Web applications 
and Web Services. ASP.NET is the next 
generation of Microsoft’s Active Server 
Pages, a technology that was widely used 
to create Web applications in the 90s and 
early 2000s. ASP.NET represents not only 
the newest in Microsoft’s Web technol-
ogy arsenal, but also one of the most 
advanced Web development platforms 
currently available.

	 ASP.NET by itself is actually just a 
small part of a larger development frame-
work created by Microsoft, known col-
lectively as the .NET Framework. The .NET 
Framework is a software development 
platform that is used to build and deploy 
applications for a variety of uses, rang-
ing from Web-based applications to Web 
Services to desktop-based applications. 
Although created by Microsoft, the .NET 
Framework is an Open Source standard, 
designed to be completely platform-inde-
pendent, and therefore isn’t restricted to 
execute on a Microsoft-based operating 
system.
	 The Open Source, platform-indepen-
dent distribution of the .NET Framework 
is called Mono and is available at www.
gomono.com. Among other things, the 
Mono Framework lets ASP.NET applica-
tions be deployed on non-Microsoft base 
Web servers, such as Linux or Sun.
Languages like ASP.NET are typically 
referred to as “server-side” languages 
because, unlike Flash applications, which 
are displayed and execute in the Flash 
Player on a user’s computer, server-side 
languages perform their magic on a Web 
server. Typically, server-side languages 
like ASP.NET are used to generate HTML 
documents that are sent to a browser 
for display. Server-side languages are 
used, for example, to generate all of the 
content you see on large-scale sites like 
www.amazon.com or www.cnn.com. 
When used in conjunction with Flash, 
however, ASP.NET is used instead to 
access and process information, pack-
age that information in a well-defined 

manner, and transmit that information 
to a Flash interface, which displays it for 
a user. Its ability to function in this role 
lets developers access the powerful func-
tionality of ASP.NET without relying on 
HTML as a user interface. Instead, a rich 
interactive medium such as Flash can be 
employed, dramatically increasing the 
capabilities of Web-based applications. 

Why Use ASP.NET for Flash 
Development?
	 Just because ASP.NET is one of the 
newest and most powerful server-side 
platforms available doesn’t necessarily 
make it a good match for Flash devel-
opers. It’s because some of ASP.NET’s 
underlying features match up perfectly 
with the needs of Flash development that 
make it a perfect server-side comrade. 
And not only does ASP.NET provide all of 
the machinery necessary for Flash devel-
opment, but it makes that machinery 
easy to operate, taking care of much of 
the underlying grunt work that other lan-
guages don’t.
	 One of the foundations of the .NET 
Framework and ASP.NET is called the 
Framework Class Library (referred to as 
FCL). The FCL is a collection of reusable, 
commonly used objects. These objects let 
developers build on complex code that 
has already been created, eliminating 
the need to “reinvent the wheel” in your 
application. The Framework Class Library 
is very similar to the pre-built classes 
and components provided in Flash such 
as MovieClip, Button, and variable types 
such as String and Number. The libraries 
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in FCL include tremendously powerful 
collections, such as ADO.NET – the .NET 
Framework’s data access libraries – and 
ASP.NET – the libraries that give .NET the 
ability to create and distribute Web appli-
cations. Access to the FCL gives devel-
opers a major jumpstart in application 
development, allowing focus to reside on 
the higher-level design of the application 
and steer clear of unnecessary dirty work. 
For Flash developers specifically this 
means that you can spend more time on 
the Flash side of the application and less 
on server-side functionality.
	 One of the classes included in FCL 
that makes integrating with Flash a 
breeze is Web Services. Using ASP.NET, 
the creation of Web Services is a very 
painless process, since much of the 
underlying work is already contained in 
FCL. Web Services make it possible for 
developers to execute complex functions 
with an ASP.NET application and return 
complex results to a Flash application 
without having to create complicated 
data-formatting procedures. 
	 Another reason that Flash develop-
ers will find ASP.NET a good match is 
the programming language commonly 
used to create ASP.NET applications, 
C#. C# (pronounced see sharp), is the 
newest language in the C family of 
languages. C# is a best-of-breed lan-
guage combining the most popular 
features of C++, Java, and Visual Basic 
– which share the same foundations as 
ActionScript’s foundation, JavaScript. 
Because C# and ActionScript have 
emerged from very similar models, 
their syntax is very similar, making for 
an easy transition between the two 
languages. Like ActionScript 2.0, C# is 
also a fully object-oriented language, 
which makes development very intui-
tive for an ActionScript programmer. I 
should mention that, although C# is the 
preferred language for creating ASP.NET 
applications, it’s by no means the only 
one. Because of the flexibility of the 
.NET Framework, ASP.NET applications 
can be written in any ASP.NET com-
patible language, such as VB.NET and 
JScript (Java for .NET). This flexibility 
also makes the transition process easier 
for a developer who might already be 
familiar with one of these compatible 
programming languages.

What Types of Functionality Can ASP.
NET Be Used For?
	  Although there are an infinite num-
ber of things that you can use ASP.NET to 
do, there are some powerful features that 
are commonly incorporated into Flash 
applications:

•	 Access stored data from a database: 
Using ASP.NET, it’s possible to retrieve 
data from nearly any kind of database, 
including Microsoft SQL, MySQL, 
Access, and Oracle, to display in a 
Flash-based interface.

•	 Insert and update database data: ASP.
NET can be used to update or insert 
data coming from a Flash interface into 
a database. Acting as the intermediary, 
ASP.NET can handle any database con-
nectivity issues and respond accord-
ingly.

•	 File uploads: File uploading is an 
essential feature of many Web-based 
applications. With Flash 8, Adobe 
released the ability to upload files from 
a user’s file system directly to a Web 
server, monitoring the progress along 
the way. Using ASP.NET, it’s possible for 
Flash to “hand off” the file to the Web 
server for proper placement.

•	 Image manipulation: Using ASP.NET, 
image files that exist on a Web server 
can be run through any number of 
manipulations, including resizing, 
cropping, and conversion. This can 
be a very useful feature when used in 
combination with Flash 8’s advanced 
image processing techniques and user-
uploaded image files.

•	 Security: ASP.NET is capable of many 
security-based functions that aren’t 
available when using just Flash. FCL 
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has advanced encryption and decryp-
tion algorithms built-in, making it easy 
for developers to do complex security 
techniques.

Creating ASP.NET Applications
	 Another one of the strengths of ASP.
NET for Flash developers is the preferred 
development environment used to create 
ASP.NET applications – Visual Studio.NET. 
Visual Studio.NET 2005 is one of the most 
advanced development environments in 
existence today. The features built into 
Visual Studio.NET not only help make ASP.
NET development more effortless, but 
also help developers new to .NET pro-
gramming learn these languages more 
easily. 
	 In the past, Visual Studio.NET was 
not an affordable tool for many develop-
ers, with its various editions starting at 
around $1,000. However, with its 2005 
product line, Microsoft has released 
a version of Visual Studio.NET called 
the Express Editions that is available 
free  of charge until November 6, 2006. 
Specifically for Flash developers, the 
Visual Web Developer Edition is a perfect 
tool for beginning ASP.NET develop-
ment, and is available for download at 
http://msdn.microsoft.com/vstudio/
express/vwd/. 

Methods Used for Flash-ASP.NET 
Interaction
	 When creating applications that 
make use of Flash and ASP.NET, a major 
obstacle can be the fact that they are 
two very separate systems – one execut-
ing on a client system, another on a Web 
server. Because of this separation, it’s very 
important to understand the methods 
available to communicate between the 
two systems – without the proper com-
munication channel, the two systems are 
useless to each other. As the Flash Player 
has evolved, so have many methods 
available to do this communicating.

FlashVars
	 FlashVars are a method of com-
municating between ASP.NET and Flash 
that uses tags embedded in HTML to 
exchange data. FlashVars only allow for 
one-way communication – from the 
server to the Flash Movie. Because of this, 
FlashVars aren’t an alternative for applica-
tions that require data to be sent from a 
client-side application to a Web server, 
such as an e-mail form. FlashVars, how-
ever, are a very fast and efficient form of 
communication and are often overlooked 
in circumstances where small amounts of 
data have to be sent to a Flash Movie.
	 FlashVars are unique among the 
exchange methods in that the data they 
contain is sent along with the .swf file 
when requested by a client browser 
instead of in a separate load after a Flash 
movie is loaded. This kind of exchange 
is less obtrusive to the user than other 
methods and is a good solution in certain 
circumstances.

LoadVars
	 The LoadVars object is much more 
versatile than FlashVars in terms of the 
direction and amount of data that can 
be exchanged. The LoadVars object is 
capable of either sending data to the 
server for processing, loading data 
from the server, or sending data to the 

server and waiting for a response back 
from the server in one operation. The 
LoadVars object uses name-value pairs 
to exchange data between the client and 
the server. The LoadVars object is best 
used in a scenario that requires two-way 
communication between the Flash Movie 
and server-side logic, but doesn’t require 
large amounts of data to be passed. The 
LoadVars object requires that the .NET 
developer handle the formatting of the 
exchanged data – potentially a real pain, 
depending on the amount you intend to 
pass.

XML Object
	 The Flash XML Object is another 
option for communicating between a 
Web server and Flash client. The XML 
object is very similar to the LoadVars 
object in functionality in that it can both 
send data to the Web server and get 
data from it. The difference between the 
XML object and the LoadVars object is 
the format in which the data being sent 
and received is formatted. Whereas the 
LoadVars object expects a name-value 
pair as a response, the XML object sends 
and receives a well-formatted structured 
XML document. Structured XML data 
makes the XML object much more suit-
able than the LoadVars object for han-
dling larger amounts of data.

Web Services
	 Introduced with Flash MX 2004 
Processional Edition, Web Services are 
the newest method for communicat-
ing between Flash and ASP.NET. Web 
Services use SOAP (Simple Object Access 
Protocol), an XML-based format, to trans-
fer data between the client and server. 
Web Services are an industry standard for 
exposing proprietary “services” for others 
to use in their applications. An example 
of a web Service is the search method 
offered by Google. By using this method 
through Web Services, it’s possible for 
you to make a Flash application that uses 
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the Google search engine. As mentioned 
earlier, Web Service creation is very easy 
with ASP.NET, making it an excellent 
choice for Flash applications. 

Flash Remoting for .NET
	 Flash Remoting is the most powerful 
and versatile of the options for communi-
cating between a Flash movie and a .NET 
Web server. Using Flash Remoting, it’s pos-
sible to access data directly from an ASP.
NET Web application in a secure, quick, and 
efficient way. Flash Remoting uses a binary 
message format for transferring mes-
sages between the Flash client and server-
side ASP.NET code called ActionScript 
Messaging Format, or AMF. AMF, like any of 
the other methods, travels between the cli-
ent and server over HTTP, so you don’t have 
to worry about security mechanisms (such 
as firewalls) interfering with your commu-
nication. Although modeled on the same 
protocol as Web Services, AMF is much 
more lightweight than the other communi-
cation options, and therefore travels much 
more quickly than calls using the Web 
Service connector. AMF is also securable 
using SSL, so it’s a great option for security-
sensitive applications. Using Adobe’s ver-

sion of Flash Remoting does come with a 
price tag, however. Flash Remoting for ASP.
NET is a standalone server-side component 
not included with Flash MX 2004, which 
costs $999 per Web server. Thankfully, 
there’s an Open Source alternative to the 
Adobe Flash Remoting for .NET package 
called Fluorine. Fluorine is an Open Source 
Flash (www.osflash.org) project and is avail-
able for download at http://fluorine.thesi-
lentgroup.com/.

Flash & ASP.NET Resources
	 The information I’ve covered in this 
article is just a brief overview of the world 
of Flash development with ASP.NET. I have 
recently written a book published by Friends 
of Ed called Foundation ASP.NET for Flash, 
which thoroughly covers all of the Flash-ASP 
.NET communication methods mentioned 
above, as well as a step-by-step introduction 
to ASP.NET development with C# and Visual 
Studio.NET. I encourage you to pick up a 
copy and add yourself to the growing com-
munity of Flash-ASP.NET developers. You’ll 
also find a growing source of Flash and ASP.
NET resources, as well as a support forum on 
the Foundation ASP.NET for Flash homepage 
at www.flashasp.net.  
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ome people take the dog for a 
walk, other go play a round of golf. 
Not Christophe Coenraets. His idea 
of a good time is to illustrate Flex 

and JMS integration by extending a simple 
“realtime feed” application that he built a 
while back! Web Developer’s & Designer’s 
Journal is proud to bring you each month 
two of the month’s best tips from Adobe’s 
intrepid Flex Hero.

Using Flex 2 with Flash Media Server
	 I recently built a proof of concept 
that included a call center integration 
scenario. The use case revolved around 
a user getting stuck while trying to com-
plete an online process, and engaging in 
a real time collaboration session with a 
customer services representative to sort 
out the problem. 
	 The nature of the collaboration 
between the end-user and the support 
representative was very rich and included 
the following features: 
1.	 Chat 
2.	 Videoconference / video chat 
3.	 The support representative was able to 

“drive” the end-user’s UI 
4.	 The support representative was also 

able to remotely fill in the user’s form. 
In other words, data typed in the sup-
port rep’s application automatically 
appeared (in real time) in the user’s app. 

	 From the end-user point of view, all 
this was done “in context” without ever 
leaving the application, and without 
starting any other application.

	 The application turned out to be 
really easy to implement with Flex 2:
•	 Features (1) and (3) were enabled by 

the new Message Service in Flex 2. 
•	 Feature (4) was enabled by the Data 

Services in Flex 2. Using the data 
services, two clients can point to the 
same destination (the same data set). 
Changes made by one client are auto-
matically reflected in the other client. 
No code required! 

•	 Feature (2) was enabled by the Flash 
Media Server. 

	 Here’s a simple example of how to 
integrate Flex and Flash Media Server to 
support rich media streaming and video-
conferencing. This is surprisingly easy to 
do with just a few lines of code.
	 To run this example you will have to:
1.	 Install FlexBuilder 2. You can download 

the beta here: http://labs.adobe.com/.
2.	 Install the Flash Media Server (you can 

download a free developer edition 
here: http://www.adobe.com/prod-
ucts/flashmediaserver/

3.	 Download the sample application code 
here: http://coenraets.com/apps/fms.
zip

4.	 In C:\Program Files\Macromedia\Flash 
Media Server 2\applications\flex_vid-
eoconference, create a directory called 
flex_videoconference and copy the 
main.asc file in that directory 

5.	 Create a FlexBuilder project and copy 
fms.mxml and VideoContainer.as in 
that project 

6.	 Run fms.mxml 

	 The application starts your webcam, 
publishes the captured video stream to 
Flash Media Server.and then “plays” the 
video streamed by Flash Media Sever in a 
second video component.

Embedding HTML in a Flex 
Application using an IFrame
	 I have recently been involved in 
several projects where there was a 
need to embed HTML content in a Flex 
application. Depending on the specific 
requirements of your application, there 
are a couple of approaches you can 
use... 
1.	 The Flex Text components (Label, 

Text, TextArea) support basic HTML 
formatting through their htmlText 
attribute. You can find an example of 
this approach in the Samples Explorer 
where the Code Viewer uses the HTML 
capabilities of the TextArea to provide 
syntax coloring. 

2.	 You can embed a Flex application in 
a page that also contains traditional 
HTML. The Flex application can com-
municate with the HTML document 
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 Tips and tricks from Adobe’s intrepid Flex Evangelist
by Christophe Coenraets

Note: I am not advocating that you use this 

technique as your default approach to com-

bine Flex and HTML content. Depending 

on your application, the approaches (1) and 

(2) described above may represent a better 

solution. If these approaches don’t meet 

your specific requirements, the technique 

implemented in the attached example can 

be very useful.
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(and the other way around) through 
JavaScript. You can also embed mul-
tiple Flex applications in a page. These 
applications can then communicate 
directly with each others using the 
LocalConnection API. 

	 In some cases, these approaches may 
not go far enough: You may need a single 
Flex application that embeds HTML con-
tent with no restriction in terms of HTML 
tags and features supported. 
	 In this case, another approach is to 
position an IFrame on top of a specific 
area of your Flex application to pro-
vide a container for the HTML content 
which will then appear embedded in 
the application. This technique may 
initially sound complex or cumbersome 
to implement, especially if the differ-
ent containers of your Flex application 
resize dynamically and you have to 
keep the IFrame in sync. In the attached 
example, I abstracted the complexity of 
this approach in an IFrame component 
written in mxml. The IFrame component 
extends Canvas and is used like any 
other Flex container. Behind the scenes, 
it acts as a proxy for the actual HTML 
IFrame. For example, when the IFrame 
component is resized or moved it auto-
matically asks the HTML document to 
resize/move the actual IFrame. 
•	 Run the example (resize the browser 

window to see how the IFrame is 
resized accordingly): http://coenraets.
com/apps/iframe/index.htm

•	 Download the example : http://coen-
raets.com/apps/iframe/iframe.zip

•	 View the source code: http://coenraets.
com/apps/cv.jsp?descriptor=iframe/
source.xml 

Figure 1

Advertising Index
	 Advertiser	 URL	 Phone	 Page	

CFDynamics	 www.cfdynamics.com	 866-233-9626	 21

CfUnited	 www.cfunited.com	 	 25

Community MX	 www.communitymx.com	 	 33

EdgeWeb	 http://edgewebhosting.net	 1-866-334-3932	 5

Hosting.com	 www.hosting.com	 	 41

HostMySite	 www.hostmysite.com	 	 51

InterAKT	 www.interAKTonline.com/macromedia	 4031 401.68.19	 3

Intermedia	 www.intermedia.net	 1-888-379-7729	 11

Macromedia	 macromedia.com/go/cfmx7_demo	 	 29

Macromedia Studio 8	 www.macromedia.com/go/8_studio8	 415-252-2000	 52

Stream57	 www.stream57.com	 212-909-2550x1012	 6

Vitalstream	 www.vitalstream.com	 800-254-7554	 2

“You may need a single Flex 
application that embeds HTML 
content with no restriction in terms of HTML 
tags and features supported”
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ne of the most common tasks when 
laying out the content of a web 
page is floating images to the right 
or left so that text flows around 

them. This is dead simple to do with CSS:

img {

float: right;

margin: 0 0 1em 1.5em;

}

	 A problem can arise if the text beside 
an image is not long enough to wrap 
around it. In this case, the next image 
could potentially float up into this space 
beneath the text, instead of sitting direct-
ly beneath the previous floated image. 
Once again, this is simple to fix:

img {

float: right;

clear: right;

margin: 0 0 1em 1.5em;

}

	 The addition of the clear to the 
floated image ensures that each one 
will always sit below the previous one. 
However, placing the float and clear prop-
erties on the same element can cause 
large gaps to appear in Internet Explorer 
(IE) — gaps that take more complicated 
CSS to fix than what we’ve used so far.
	 To see the problem, download the 
support files for this article and open IE_
adjacent_float_gap.html in Dreamweaver. 
Preview it in IE. Unless you have a very 
narrow screen so that the text of the 

first paragraph is long enough to wrap 
around the first image, what you will see 
should resemble Figure 1. 
	 What seems to be happening is this: 
IE floats the first image to the right. The 
text of the paragraph that follows it 
wraps around it. Next up in the XHTML 
source is the second image, which is also 
floated to the right and cleared below 
the first image. But instead of allowing 
the text that follows the second image to 
flow up beside the first image, as it ought 
to, the text acts as if it, too, had a clear 
applied to it.
	 When an IE bug is present, the first 
line of defense is to see if it falls to either 
of the two “magic bullets” described in 
How To Attack An Internet Explorer (Win) 
Display Bug by Holly Bergevin and John 
Gallant. I’ll save you some trouble — this 
one doesn’t. No matter which elements 
you apply position: relative or height: 1% 
to, the gap remains.
	 What to do now? Georg Sørtun, a 
helpful and inventive member of css-dis-
cuss, came up with the idea to make the 
content adjacent to the floats inline. For 
some reason, perhaps because the clear 

property can only be applied to block-
level elements, the content no longer 
acts like it is inheriting the clear, and the 
gap is gone.
	 Go to the Code View of IE_adjacent_
float_gap.html. Add the conditional com-
ment block below that includes special 
styles for IE only to the head of the docu-
ment, below the closing style tag.

<!--[if IE]>

<style type=”text/css”>

p {

display: inline;

}

</style>

<![endif]-->

	 If you preview in IE after adding the 
above code, you will see that the gap 
is now gone. Of course, since the para-
graphs are all inline now, they all run 
together as one big lump of text. This is 
even worse than before!
	 Luckily, we can make IE treat the para-
graphs like blocks again, without making 
the gap return, by giving them “layout.”
	 The Holly Hack, described in the article 
How To Attack An Internet Explorer (Win) 
Display Bug referenced earlier, is one way 
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Close Gaps Next to 
Floating Images in Internet Explorer

Creative fixes
by Zoe Gillenwater

In a real page, the styles for all browsers 

would be placed in one style sheet, which 

would be linked or imported from the head 

of the page, while the styles for IE would be 

linked or imported from within the condi-

tional comments. Here, the styles are listed 

within the head of the page itself for your 

ease of editing.

“hasLayout” is an IE-only property that 

makes certain IE bugs disappear and 

changes how elements are laid out and 

relate to each other. If you want to dig into 

how hasLayout works, read this excellent 

article by Ingo Chao, On having layout. 
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to give an element layout because it sets 
a dimension on the element. But the Holly 
Hack doesn’t work here. Georg Sørtun 
had the answer again, though: use zoom 
instead. This is another IE-only property 
that induces layout, and if we set it to “1” it 
will not change the appearance of the text 
(if set to 2, it would zoom in to make the 
text twice as big, for instance). When it is 
applied to the paragraphs, they split apart 
again. With some padding added between 
them, they look like normal paragraphs 
once more (see Figure 3). Modify your IE-
only CSS to match the block below:

p {

display: inline;

zoom: 1;

padding: .5em 0;

}

Although an h2 element, not just para-

graphs, is also adjacent to the floated and 

cleared images, applying this fix to the 

paragraphs only was good enough in this 

case — IE is a mysterious browser! However, 

on real pages that are more complicated, 

you may need to apply the fix to all content 

that is adjacent to gap-inducing floats. 

Tinkering is always present when IE needs 

to be supported!

	 The only other thing we may want to 
tweak at this point is the spacing of the the 
headings in relationship to the paragraphs. 
Headings have default top and bottom mar-
gins. These margins are butting up against 
and adding to the padding we’ve applied to 
the paragraphs to space them out from one 
another. So, add these additional rules within 
the conditional comment:

h1 {

margin: .3em 0;

}

h2 {

margin: .5em 0;

}

	 Now the spaces between the head-
ings and paragraphs are consistent with 
how they looked before.
	 There’s one niggling side effect of this 
method. If you scroll down the page, you 
will see that the paragraph that is adja-
cent to the bottom of the second photo 
no longer wraps around that photo’s bot-

Figure 1
Figure  2

Figure 3
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tom (see Figure 4). This new gap cannot 
be prevented or fixed. However, it will 
occur much less frequently than the first 
gap, usually be smaller in size, and is gen-
erally easy to overlook, so this solution is 
best for most situations.
 	 If, however, you have a very picky cli-
ent who uses IE and cannot stand the gap 
underneath some images, there is another 
method that you can use, courtesy of Ingo 
Chao, another creative css-discuss member. 
	 Go back to your XHTML file and 
remove the entire conditional comment 
— it’s no longer needed. Instead, add the 
following class:

.fixgap {

float: right;

height: 0;

}

	 Then, add this line of HTML immedi-
ately before the second floated image:

<div class=”fixgap”><!-- --></div>

	 Preview the file in IE. Both the gap 
above the text and below the photo will 
be gone.
	 You can add this empty div above 
every float-clear combination element. If 
you go with this method, keep in mind 
that you are adding unneeded bulk to 
your pages and that there’s a chance 
(especially if your pages are maintained 
by someone else) that the empty divs 
could be accidentally removed down the 

road. For these reasons, the first method 
is recommended in most cases.

Summary
Recommended Fix
	 Add this rule to an IE-only style sheet: 

p {

display: inline;

zoom: 1;

padding: .5em 0;

}

	 Also, adjust margins on any content 
adjacent to the paragraphs.
	 See the file IE_adjacent_float_gap_
fix1.html.

Alternate Fix
	 Add this rule to the main style sheet:

.fixgap {

float: right;

height: 0;

}

	 Add this line of HTML immediately 
before the float-clear combination ele-
ment:

<div class=”fixgap”><!-- --></div>

See the file IE_adjacent_float_gap_

fix2.html.

	 Thanks to Georg Sørtun, Ingo Chao, 
and Bruno Fassino for their creative fixes 
to yet another IE bug! 

Figure 4
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